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Project Overview 
 

Introduction to TechnoAdvertise 

 

In this project, students design advertisements using Microsoft Word. To start, students learn the word processing skills 

necessary to create a cover letter and résumé, to apply for a job at TechnoAd Agency. Once hired by the agency, 

students' first assignment is to produce a flyer using advanced graphic techniques. Next, students develop a 

product catalog that includes styles, table of contents, and an index. Afterwards, they learn how to complete a 

mail merge to produce a personalized form letter for a client to promote an upcoming event. Finally, students 

combine their skills to design a newsletter. Interwoven throughout the project are enrichment activities that involve 

business-related tasks.  

 

Let the creative talents of your students shine using TechnoAdvertise! 

 

Students complete the following tasks: 

 

➢ In session 1, students apply for a job at TechnoAd Agency. To prepare for this task, students 

review cover letters and résumés and then answer questions to determine their qualifications. 

Once they have a list of their characteristics, skills, and experiences that make them a perfect 

match for the position, they open Microsoft Word to gain familiarity with the program. Next, they 

follow detailed instructions to write a professional cover letter and résumé. Upon completion, 

students address an envelope to send their application using traditional mail. They combine their 

cover letter and résumé and save the file as a PDF document to send digitally using email. These 

well-formatted business documents are sure to draw the attention of TechnoAd Agency! 

➢ In session 2, students begin work for TechnoAd Agency. Their first task is to design a flyer for 

TechnoTeen Company. TechnoTeen Company sells shoes, clothing, and accessories to 

teenagers. They have requested a flyer to promote their Summer Heat sales event. To prepare for 

this task, students answer questions to learn about the objects on the Insert tab that can be 

added into a document. Once familiar with the range of options, they follow detailed instructions 

to produce an eye-catching ad using pictures, shapes, and more! The flyer is sure to draw 

attention with a SmartArt Graphic highlighting sales items, colorful header and footer that list 

store details, text box with discounts, and a catchy phrase written using WordArt. This 

advertisement is sure to sizzle! 

➢ In session 3, students are responsible for creating a catalog, which contains an itemized list of 

products for sale. To complete this publication, the task is divided into two phases. In Phase 1, 

students create the catalog content. In Phase 2, they add page references to make the 

information easy for customers to find quickly. Phase 1 begins with students exploring the 

commands on the Layout tab. Next, they select the products to include in the catalog using an 

organizer. With a plan in place, students start construction of the catalog. They use their skills to 

divide a document into sections. Using layout commands, they add unique headers and footers 

to each section, produce a cover page, apply a watermark to the table of contents, and 

arrange a company message on a page with custom margins, columns, and a fancy border. 

Students then learn how to insert and format a table to produce an order form and product 

pages. 

➢ In session 4, students complete their catalog by inserting page references. To prepare for this task, 

students explore the function of commands on the References tab. They follow a set of 

instructions to edit a document so that it includes a table of contents, footnotes, endnotes, 

citation, bibliography, caption, and an index. Afterwards, students apply their skills to add 

references to their catalog to permit customers to find information fast. Upon completion, they 

use a checklist to verify that their document is ready for publication. Customers are going to 

appreciate how easy it is to find the items they would like to order. 
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➢ In session 5, students invite customers to an exclusive shopping event using mail merge. Mail 

merge places unique information into a document that has placeholders. Using the Mail Merge 

Wizard, students add customer records, write a form letter, and merge data into placeholders on 

the letter to produce a personalized invitation. Afterwards, they generate mailing labels for each 

letter using commands on the Mailings tab. 

➢ In session 6, students produce a newsletter for an organization to inform members about 

activities. The publication will include a brief article about a recent event, special appreciation 

section, upcoming events, reminders, tips, and a calendar. The goal is to have students apply 

their word processing skills to create the publication. For example, they will use their knowledge of 

Microsoft Word to format text, modify styles, insert objects, adjust page layout, and create a 

table of contents. Upon completion students use commands on the Review and View tabs to 

improve the content, design, and layout. Members are going to be well informed after reading 

this newsletter! 
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Implementation and Technology Integration Ideas 
 

TechnoAdvertise uses business-related scenarios to develop competency in using Microsoft Word. As students 

play the role of first applying for a job at an advertising agency and then designing a sales flyer, product catalog, 

custom mailer, and newsletter for clients, they master technology and workplace skills. Instructions explain how to 

produce publications that professionals create in real life. The activities prepare students for higher education and 

the future careers.  

 

 

• Computer Applications Course 

Include this project as part of a computer education course. Students master fundamental and 

advanced word processing skills in creating tables, setting styles, formatting graphics and smartart, mail 

merge, making a table of contents, generating an index, and more.  

 

• Career Training 

TechnoAdvertise is a seamless fit into Careers courses. The project begins with students being guided 

through writing a resume and cover letter. Engage student interest in meaningful activities that connect 

to authentic tasks. Develop vital technology and fundamental workplace skills. Foster professional skills 

such as time management, creativity, perseverance, and initiative with the activities, checklists, and 

assessment tools provided. Promote career readiness, STEM, and ICT proficiency.  

 

• Business Education Course 

TechnoAdvertise is based in the marketplace. The scenarios are relevant to the workplace. The activities 

provide students the opportunity to develop technology skills they can use as they follow their career 

path.  

 

• Microsoft Office Specialist (MOS) Certification Prep 

Provide practice activities your students will enjoy while they prepare for the MOS certification exam. In 

this project, students apply their knowledge of Microsoft Word tools and features to create and edit 

publications. The practical tasks familiarize students with program functionality. 

 

• Marketing Unit 

Include this project as part of a marketing unit. The activities have students assume the role of an 

advertising agent. By producing advertisements in Microsoft Word, they learn how to connect with 

customers, effectively communicate information, and promote sales events. 

 

 

Understanding the Big Picture 

 

Not sure where to integrate TechnoAdvertise? There are samples provided for all the publications created in this 

project. These samples provide ideas on how you can include these activities into curriculum. Samples also give 

students a clear picture of what is required before beginning a project, as well as sparking their creativity. 

 

✓ Résumé and Cover Letter samples: Ivanna Job, Ned Money, and Shirley Imgreat Résumés and Cover 

Letters offer a variety of design, style, and formatting versions to inspire students. 

 

✓ Flyer sample: Flyer Sample demonstrates all the parts of the task - inserting and formatting clip art, a 

picture, a shape with text, wordart, a smartart graphic, a text box, and adding a header and footer. 

 

✓ Catalog samples: Students can view completed catalogs for furniture, pet, and tea companies to gain 

an understanding of the advanced word processing skills taught in this assignment. Seeing a finished 

product in advance of making their own allows students to grasp concepts such as styles, table of 

contents, cross references, order form tables, product categories, index, and more. 

 

✓ Newsletter samples: Newsletter 1 is a publication from a hockey association, Newsletter 2 is a sample of a 

school newsletter, and Newsletter 3 is written from the viewpoint of a toy lending library. Students examine 

the samples to gain ideas and motivation for their creations. 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Assignment 3: Write a Cover Letter 
 

A cover letter is a business letter that accompanies your résumé when you apply for a job. It 

offers a way for job seekers to tell employers why they should be hired. The most important 

thing in a cover letter is to show that your skills match those advertised in the job posting. Make 

a cover letter using Microsoft Word to apply for the Advertising Agent position at TechnoAd 

Agency. 

 

 

Employment News 
    

Company: TechnoAd Agency 

2097 TechnoDrive 

TechnoVille, ON 

L7R 0A5 
 

 

TechnoAd Agency has over 15 years of experience in the advertising industry. Our company works closely 

with clients to design effective marketing material. We are looking for creative individuals interested in 

joining our team. 

Job Number:  112233 

Position:  Advertising Agent 

Job Description: Create advertisements for clients including flyers, product catalogs, and newsletters. 

No experience is necessary, willing to train. 

Requirements: • Ability to work in a fast-paced environment 

• Excellent communication skills 

• Work effectively in a team setting 

• Able to work independently 

• Strong time management skills 

• Design or artistic skills an asset 

• Strong computer skills 

Interested candidates should forward a résumé and cover letter to the attention of: 

Teacher Name, by email _____________ 

or by mail to TechnoAd Agency, 2097 TechnoDrive, TechnoVille, ON L7R 0A5 
 

 

 

Open Microsoft Word 

 Open Word. 

 Click Blank document. 

 

Write the Header of the Letter 

 Type Student Name. Press ENTER. 

 Type Street Address. Press ENTER. 

 Type City, State/Province Postal/Zip Code. Press ENTER twice.  

 Type the Date. Press ENTER twice. 

Look at the job ad. It includes TechnoAd Agency's contact information.  

 Type the recipient's contact information. 

 Press ENTER twice. 

 Type the greeting Dear Name of Teacher:   

 Press ENTER twice. 

  

You are going to type the 

letter. After it is written, you 

will format the appearance. 

Ivanna Job 

10 Hierme Road 

Jobb, ON L8W2J1 

 

November 1, 2021 

 

Mrs. Teacher 

TechnoAd Agency 

2097 TechnoDrive 

TechnoVille, ON L7R 0A5 

 

Dear Mrs. Teacher: 
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Write the Introduction 

 Type a sentence that describes the purpose of the letter.  

Include the job title, job number, and location of the ad. Be specific! For example: 

 

 Type one or two sentences to convince the employer that you should be considered for the position. Be 

persuasive! For example: 

 
 

 

Write the Body of the Letter 

 Read the ad. Select three or four requirements that you meet. In a new paragraph, create a list that 

summarizes why you should be hired. Be detailed! For example: 

 
 

 

Write the Closing of the Letter 

 In a new paragraph, type two or three sentences that outline the steps you want the employer to take to 

contact you about the position. Be confident! For example: 

 

 (Optional) Type a closing line such as I look forward to hearing from you or Thank you for your 

consideration.  

 Press ENTER twice. 

 Type a farewell line such as Yours Truly or Sincerely. Use a comma after the farewell.  

 Press ENTER twice. 

 Type Student Name. Press ENTER. 

 Type Enclosure. This tells the employer that you have attached your résumé to the letter. 

  

I am writing in response to your advertisement for an Advertising Agent in Employment News, job number 112233. 

or 

I am interested in the Advertising Agency position in Employment News advertised on October 14, 2021.  

(The date is made up) 

After reading the description, I am confident that my skills are a perfect match for this position. I have the ability to 

create effective advertisements that will satisfy your customers. 

or  

My experience designing marketing materials to promote school events and involvement with the school yearbook 

have provided me with the skills necessary to make a valuable contribution to TechnoAd Agency. 

I possess the following attributes that would be an asset to your company: 

Quick to learn new skills 

Knowledge of Microsoft Word 

Team player 

Creative talents including painting and photography 

or  

I believe that I am a perfect match for the position. Here is a description of how my experience compares with your 

requirements: 

Cashier at TechnoRestaurant has provided me with the skills to work in a fast-paced environment 

Creating flyers to promote dances or local fundraisers has allowed me to develop strong design skills 

Business education course has taught me computer skills needed for the workplace 

Hockey team captain has allowed me to develop team building skills 

Attached is a copy of my résumé. I would welcome the opportunity to discuss my suitability for the Advertising Agency 

position. Contact me at 111-101-1001or by email at ivannajob@kneedwurc.com to schedule an interview. 

or 

Contact me to schedule an interview at 111-101-1001 or by email at ivannajob@kneedwurc.com. I look forward to 

discussing my qualifications with you in more detail. 

You will format this list 

using bullets. 
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Format the Letter 

 

 Format the font: 

o Press CTRL + A to select the entire document. 

o From the Font group on the Home tab, click the Font arrow.  

o Select a suitable typeface for a business letter, such as Arial or Century Gothic.  

 

 Format the font size: 

o With the text still selected, click the Font Size  arrow. Select font size 10.  

o With the text still selected, click Increase Font Size to make the words larger.  

o With the text still selected, click Decrease Font Size to change the size back to 10.  

 

 

 Apply the bold style:  

o Triple click the mouse on Student Name at the top of the page to select the text. 

o Click Bold    in the Font group to make the words stand out.  

Notice that the command is now selected.  

o If you want to remove the Bold font style, click on the command  again.  

 

 Apply italics and an underline:  

o Click to place the cursor in front of the job title in the introductory paragraph.  

o Click and drag the mouse to select the Advertising Agent job name.  

o Click Italic  in the Font group to slant the job title to the right.  

o Double click on the job number to select 112233. 

o Click Underline  in the Font group to underline the job number.  

 

 Bullet a list:  

o Rest the mouse pointer in the margin in the body of the letter near the first listed item.  

The mouse pointer will change to a white arrow.  

o Click and drag DOWN to select the list. 

 
 

o From the Paragraph group on the Home tab, click Bullets.  

  

You are now going to format the letter. You will learn how to use some of the 

commands in the Font group and Paragraph group of the Home tab. You 

will also practice using different methods to select text and ways to move 

around the document. 

Font group Paragraph group 
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 Adjust line and paragraph spacing of the contact information:  

o Press CTRL + HOME to place the cursor at the beginning of the document. 

o Press the SHIFT key, while at the same time pressing the DOWN arrow on the keyboard to 

select the job seeker's contact information, date, and recipient's contact information.  

 

o Click Line and Paragraph Spacing  from the Paragraph group.  

Select 1.0 from the menu. 

o With the text still selected, click Line and Paragraph Spacing again and  

select Remove Space After Paragraph. 

 

 Adjust line and paragraph spacing of the enclosure: 

o Press CTRL + END to place the cursor at the end of the document. 

o Double click to select the word Enclosure. 

o Click Line and Paragraph Spacing from the Paragraph group.  

o Select Add Space Before Paragraph. 

 

 

 Align text to the left, center, right, and justify: 

o Click and drag the vertical scroll bar to view the top of the page. 

o Use your skills to select the date. 

o Click Align Right from the Paragraph group.  

o With the text still selected, click Center.  

o With the text still selected, click Align Left.  

o From the Editing group on the Home tab, click Select.  

 From the menu, click Select All. 

 

 
 

o Click Justify  from the Paragraph group.   

Ivanna Job 

10 Hierme Road 

Jobb, ON L8W2J1 

. 

November 1, 2022 

. 

Mrs. Teacher 

TechnoAd Agency 

2097 TechnoDrive 

TechnoVille, ON L7R 0A5 

. 
Dear Mrs. Teacher: 

Justify adjusts the 

spacing in a line of text 

to create a block with 

an equal space at the 

left and right margins. 



 Session 1 

Copyright © TechnoKids Inc. 1-25 TechnoAdvertise | Microsoft 365 

Format the Page Layout 

 
 

 Change the page margins: 

o Click the Layout tab. 

o Click Margins  from the Page Setup group.  

o From the menu, select Normal. 

 

 Change the indent level of a paragraph: 

o Click the mouse inside a bulleted item. 

o From the Paragraph group, on the Layout tab, look in the Indent area. Increase the Left 

indent by clicking on the UP arrow. 

o Now decrease the Left indent by clicking on the DOWN arrow. 

o Type in 0.3 in the Left indent box. Press the ENTER key on the keyboard. 

 

 Use your skills to change the indent level on each item in the bulleted list. 

 

 Change the spacing of a paragraph: 

o Click the mouse inside the space below the farewell line. This is where your signature will go. 

Therefore, you might need a bit more space to sign your name. 

o From the Paragraph group, on the Layout tab, look in the Spacing area. Increase the After 

spacing by clicking on the UP arrow. 

o Now decrease the After spacing by clicking on the DOWN arrow. 

o Type 20 in the After spacing box. Press the ENTER key on the keyboard. 

 
  

You are now going to adjust the page layout using commands on the Layout 

tab. This will allow you to change the margins, adjust indent levels, and set 

paragraph spacing. 
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Edit the Document for Spelling and Grammar Errors 

 

 Check spelling: 

o Right click on a word that Microsoft Word has identified as a spelling error. 

 

 
 

o Select the correct word from the list of suggestions or if the word is  

spelled correctly, then click Ignore All. 

 

 

 Check grammar: 

o Right click on a word that Microsoft Word has identified as a grammar error. 

 

 
 

o Select the punctuation or wording from the list of suggestions that will fix  

the error or if you think the grammar is correct, then click Ignore Once. 
 

  

Your cover letter cannot have spelling or grammar errors. While you were 

writing the letter, Microsoft Word automatically underlined possible errors. 

Red wavy lines show a spelling error. A double blue line shows a grammar 

error. You can right click on these lines to view a list of suggested 

corrections. Try it. 



 Session 1 

Copyright © TechnoKids Inc. 1-27 TechnoAdvertise | Microsoft 365 

Complete the Cover Letter Checklist and then Print the Cover Letter 

 

 Adjust the Zoom Slider to view the whole page.  

 Read the letter. Does your cover letter convince a reader to consider you for the job position? 

 Use the checklist to verify the cover letter is complete. 

Header 

 name of job seeker and address 

 date of writing 

 name of recipient and address 

 greeting line (Dear Teacher Name) 

Introduction 

 purpose of letter 

 job title, job number, and location of ad 

 convincing sentence about qualifications 

Body 

 list of at least three job requirements that the applicant possesses 

Closing 

 next steps for employer to take 

 farewell line (Yours Truly, Sincerely) 

 signature line 

 enclosure line 

Formatting 

 text is a suitable font and size for a cover letter 

 bold and italic styles highlight important data 

 bullets are applied to a list 

 test is justified 

 margins, indent level, and paragraph spacing are formatted 

Professional Publication 

 free of spelling and grammar errors 

 

 Make any adjustments to the document. For example, you may want to increase the font size, change 

the font, adjust the margins, or increase paragraph spacing. 

 When you are ready to print, click the File tab, and select Print. 

 Click Print.  

 

Save the Cover Letter and Close Microsoft Word 

 Click Save on the Quick Access Toolbar.   

 Go to the location where you save your files. Name the file cover letter. Click Save. 

 Close the document. 

To prepare your document for printing, it is a good idea to preview the 

whole page. This way you can correct any problems with the page layout. 

Once you think the cover letter is ready, send it to the printer. 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 1 Review: About Microsoft Word 
 

1. Label parts of the Microsoft Word window. 

 

Ruler Title Bar Home Tab Zoom Slider Quick Access Toolbar 

 

 
 

1. Quick Access Toolbar 2. Title Bar 3. Home Tab 

      

4. Ruler 5. Zoom Slider   

/5 

 

 

 

6. Match the terminology to the correct definition. 

  
D line spacing 

 
a. The amount of space between letters. 

C paragraph spacing 
 

b. The amount of space between the margin and a selection of 

text. 

B indent level 
 

c. The amount of space before and after a paragraph. 

E margins 
 

d. The amount of vertical space between the lines of text in a 

paragraph. 

A character spacing 
 

e. The amount of white space around the page at the top, bottom, 

left, and right. 

/5 
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Select the correct answer from the list. 

 

7. Which keyboard shortcut places the cursor at the end of the document? 

 a. CTRL + A 

 b. CTRL + END 

 c. SHIFT + HOME 
   

8. Which method will select a paragraph? 

 a. Triple click the mouse inside the paragraph 

 b. Right click the mouse 

 c. Use the keyboard shortcut CTRL + HOME 
   

 

9. Which method will paste a selection? 

 a. Double click the mouse and select Paste. 

 b. Right click the mouse and select Paste from the Shortcut menu. 

 c. CTRL + C /3 
 

 

 

Select the command to complete the task. 

 

10. Apply shading to a paragraph. 

 a. 
 

b. 
 

c. 
 

 

   

   

11. Set page margins. 

 a. 
 

b. 
 

c. 
 

 

   

   

12. Change line spacing. 

 a. 
 

b. 
 

c. 
 

 

   

   

13. Copy formatting from one place and apply it to another. 

 a. 
 

b. 
 

c. 
 

 

   

   

14. Justify text to create block paragraphs. 

 a. 
 

b. 
 

c. 
 

 

   

   

15. Add a borderline. 

 a. 
 

b. 
 

c. 
 

 

   

   

16. Show hidden formatting symbols such as spaces, paragraph markers, and tab markers. 

 
a. 

 

b. 
 

c. 
 

 

/7 

 

Total:    /20 
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Session 1 Skill Review: Write a Job Acceptance Letter 
 

Congratulations! You have been offered the job at TechnoAd Agency. You will now apply your 

word processing skills to write a letter accepting the job offer. 

 

Even if you have accepted a job over the phone, it is a good idea to write a job acceptance 

letter to confirm the details of employment and to accept the job offer formally. Follow the 

instructions to write a professional letter. Sample text is provided to help you gain an 

understanding of the task. However, use your creativity to write your own unique letter. 

 

1. Open Word. 

  

2. Type your contact information: 

 Student Name 

Street Address 

City, State/Province Zip/Postal Code 

 Press ENTER twice. 

  

3. Type date. 

 Press ENTER twice. 

  

4. Type recipient information: 

 TechnoAd Agency 

2097 TechnoDrive 

TechnoVille, ON L7R 0A5 

 Press ENTER twice. 

  

5. Type greeting such as Dear Name of Teacher: 

 Press ENTER twice. 

  

6. Type a sentence that summarizes the purpose of the letter. (accept Advertising Agent job position) 
 I am writing to accept the position of Advertising Agent with the TechnoAd Agency.  

  

7. Type a sentence that states details of employment. (job duties, salary, benefits) 
 I welcome the opportunity to join your team to create effective marketing materials for your customers. 

  

8. Type a sentence that states the start date. 
 I look forward to starting work on January 27, 20XX 

 Press ENTER twice. 

  

9. Type a closing line that shows appreciation for the opportunity. 
 Thank you for the opportunity. 

 Press ENTER twice. 

  

10. Type a farewell line such as Sincerely, or Yours Truly, 

 Press ENTER four times. 

  

11. Leave space for a signature. Type Student Name.  

  

12. Select the entire document. 
 

  

13. With the text selected, change the font to Times New Roman. 
 

  

14. With the text selected, change the font size to 12. 
 

  

15. With the text selected, justify the alignment. 
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16. Adjust the line spacing in the document area to 1. 
 

   

17. Remove the Before and After paragraph spacing in the document. 
 

   

18. Select Student Name. Apply the bold style. 
 

   

19. Select the job title. Apply an italic style. 
 

   

20. Customize the left and right margins to 2".  

 a. Click the Layout tab.  

 b.  Click Margins in the Page Setup group. 
 

 c. Select Custom Margins.  

 d. In the left margin box type 2. In the right margin box type 2. Click OK. 

  

21. Edit the spelling and grammar. 
 

  

22. Save the letter as job acceptance letter. 

  

23. Print the letter. At the bottom of the letter, in the space above Student Name sign your name. 

  

24. Exit Word. 
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Session 1 Extension Activity: The Interview 
 

 
Stage a Mock Interview 

 

Choose one of the following scenarios to stage a mock job interview. The person playing the role of the 

interviewer will use questions selected from the next page. 

 

• Interviewer and Interviewee: Pair up students. Assign one student the role of being the interviewer and the 

other the interviewee. Have the interviewer ask questions. Afterwards, have the students switch roles.  

• Group Interview: Divide students into groups of four. Assign a group member to be the interviewer. The 

remaining group members are job candidates. Give the interviewer two questions to ask job candidates. 

Each job candidate can take a turn answering the question. Afterwards, have the interviewer select the 

candidate they believe is best suited for the job position based on their responses. The interviewer must 

explain the rationale for their decision. Now rotate roles. Have a job candidate become the interviewer. 

Repeat this process until each group member has been the interviewer.  

• Panel Interview: Select 5-10 students to be job candidates. Have the remaining students become part of 

the panel of interviewers that work for TechnoAd Agency. Set up the room so that the panel is at the front 

of the room with the job candidates' desks arranged in a semi-circle in front of the panel. Give each 

interviewer a question. For each question, the interviewer can select two candidates to answer. After the 

interview, discuss the process. Be sure to draw attention to quality responses, suggestions for improving 

answers, as well as methods to cope with stress that can be caused by taking part in a panel interview. 

• Perfect Answer: Divide the students into groups of four. Assign a group member to be the interviewer. The 

remaining group members are job candidates. Give the interviewer two questions to ask job candidates. 

Each job candidate can take a turn answering the question. After the interview, within the groups, 

students discuss the strength and weaknesses of responses. Now as a group, generate the "perfect" 

answer to the question by combining the responses. Select a group member to share their answer with 

the entire class. Afterwards, discuss how the perfect answer is different for each person, but emphasize 

the point that carefully planning a "perfect" answer before the interview is a great way to be confident 

when asked the question. 

• Two-Headed Monster: Two heads are better than one! Interviewing can be a stressful experience. 

However, having a friend help with preparing answers is one way to make answering questions fun. Divide 

the students into groups of three. Assign a group member to be the interviewer. The two remaining 

students are to combine their strengths, skills, and experiences to answer the question as if they are a 

"two-headed" monster. Give the interviewer a question to ask the two-headed monster. After being 

asked the question, the two-headed monster can quietly discuss their answer for 60 seconds. After that 

time, they must select a "head" to deliver the response confidently. Rotate the role of interviewer and 

two-headed monster. 

  

Interview Tips: 

✓ Be well-groomed and dress neatly 

✓ Shake the hand of the interviewer using a firm handshake 

✓ Take an extra copy of your résumé and a list of references 

✓ Ask the interviewer to repeat the question if you are not sure what they are asking 

✓ Take a breath to relax before answering a question 

✓ Speak clearly 

✓ Lean toward the interviewer to show that you are interested 

✓ Be calm and do not fidget 

✓ Do not chew gum or cross arms over chest when answering a question 

TechnoAd Agency is interested in YOU! They 

have scheduled an interview. 
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Interview Questions: YOU ARE APPLYING FOR THE ADVERTISING AGENT POSITION 
 

1. Tell me about yourself. 

 

Tip: Often interviewers will ask this question first to relax you. Keep the answer brief, only two or three minutes long. 

Limit your answer to work-related items. Talk about things you have done and jobs you have held that relate to the 

position. Hint: Refer to your summary on your résumé. 

2. What is your greatest strength? 

 

Tip: This question lets you tell the employer why you are perfect for the job. Describe an attribute you possess such as 

determination, responsible, energetic, or creativity and then explain how it has helped you in the past to complete 

a task and why it will be an asset to this position. 

3. What experiences do you have that qualify you for the position? 

 
Tip: Be specific! Have a list of two or three things you have done that will make you a perfect match for the position. 

For example, list three marketing items you have made, their purpose, and production methods used. 

4. What have you done in the last year to improve your knowledge or skills? 

 
Tip: Many companies are willing to train, but you must show them that you are willing to learn. Describe a time when 

you learned a new skill and describe how you responded to the learning situation. 

5. Tell me about your ability to work under pressure in a fast-paced environment. 
 Tip: Say you thrive under pressure. Give an example of when you worked in this environment and why you liked it. 

6. Rate your communication skills on a scale of 1 to 10, with 10 being excellent. 

 

Tip: Give yourself a high score. Then provide two or three examples. For example, you may want to mention ways 

you have used media to communicate a message effectively, strengths you possess in face-to-face discussions, 

written or public speaking abilities, or methods you use to communicate. 

7. Describe a difficult situation and explain how you handled the challenge. 

 

Tip: This question is based on the belief that how you behaved in the past will predict how you will behave in the 

future. For this reason, have an example ready about a difficult co-worker, team member, or assignment. Briefly 

describe the situation and then focus the rest of your answer on the methods used to solve the issue. 

8. Do you prefer to work independently or on a team? 

 
Tip: This is a trick question. Answer that you prefer BOTH depending on the task then give an example of a task that 

you enjoyed doing independently and another where you liked being part of a team.  

9. Describe a time when your workload was heavy and how you handled it. 

 
Tip: You need to show you have excellent time management skills. Give an example of how you met a deadline, 

adjusted your schedule to balance many activities/tasks, or the methods you use for scheduling. 

10. What level of proficiency do you have with using the computer? 
 Tip: Be honest. Describe the programs you can use or tasks you can complete using the computer. 

11. What are your long-range plans or objectives? 

 
Tip: Focus on your career goals and what you are doing to achieve those goals. For example, say "I would like to 

become the best X and to achieve that I am doing Y and Z."  

12. What is your greatest weakness? or In what area of your work do you need to improve? 

 

Tip: Do not say I get easily bored, stressed, depressed, or angry, nor mention a key requirement of the job as an area 

of weakness. Instead, select an area of knowledge or skill where you would like to improve and demonstrate how 

you overcame the shortcoming. For example, say "I am weak in X. I always have to do Y to overcome this 

weakness." For example, if you have a poor memory, say you have to make lists; if you aren't good at math, say you 

use a calculator; or if you have limited spreadsheet skills explain that you are taking a course. 

13. Why did you leave your last job? or Why do you want this job? 

 
Tip: Be positive. NEVER refer to a problem with management or speak ill of co-workers at a previous job. Instead, say 

you want to learn something new, have a new opportunity, or a new challenge. 

14. What do you know about this organization? 

 

Tip: This question proves that you are interested in the job position. It is a good idea to research a company BEFORE 

going to the interview. For this assignment, the INFORMATION IS IN THE AD. However, for other jobs, a great method is 

to use the Internet and read the company website to learn about products/services.  

15. Do you have any questions? 

 

Tip: Always ask a question because it shows you are interested in the company. Avoid asking about wages, 

holidays, or other benefits. Instead ask, "What type of projects will I be working on when I start work?" or "Do you offer 

training before I begin working with your customers and if yes, what does the training include?" 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Cover Letter Marking Sheet 
 

Contents  

Header includes job seeker information, date, recipient information, and a greeting. 
/2 

Introduction describes purpose of the letter and includes job title, job number, ad location, and a 

convincing sentence about the applicant’s qualifications. /3 

Body lists at least 3 job requirements that the applicant possesses. 
/3 

Closing includes a persuasive sentence about the applicant’s suitability for the job, a farewell, student 

name, and enclosure line. /2 

Formatting  

Font is a suitable typeface and size for a business letter.  

Bold and italic styles highlight important data.  

Bullets are applied to a list.  

Text is justified.  

Margins, indent level, and paragraph spacing have been customized. /5 

Professional Publication  

The letter is free of spelling and grammar errors. /5 

TOTAL /20 

 

 

Resume Marking Sheet 
 

Contents  

Contact information includes: 

• name 

• address 

• phone 

• email 

Education: 

• school names 

• dates 

• education-related information 

/6 

Objective: 

• sentence that clearly describes career 

goals 

Work Experience: Three jobs worked that include 

• job title 

• employer name 

• dates of employment 

• list of duties 
/8 

Summary: At least 3 sentences that describe: 

• the applicant 

• the applicant’s experience 

• how the person is a match for the job 

Relevant Skills: 

• well organized list of skills, memberships, 

hobbies, or other accomplishments that 

would interest an employer 
/6 

Formatting  

student name is formatted to stand out on the page  

consistent formatting has been applied to all sections  

bullets are used to list information  

text is easy to read  

resume fits on one page /5 

Professional Publication  

The letter is free of spelling and grammar errors. /5 

TOTAL /30 
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Flyer Marking Sheet 
 

Title  

The flyer has a title: "Summer Heat Sales Event".  

The words are formatted to attract reader’s attention. /2 

"Shoes" Picture  

Picture has been resized and/or rotated to suit flyer.  

Background has been removed.  

The formatting of the picture suits the layout and purpose of the flyer. /3 

Clip Art  

Clip art suits summer theme.  

Clip art has been formatted to look appealing. /2 

"Save" Shape  

There is a shape with the text "Save!"  

The style, fill, outline, and/or shape effects have been customized.  

The style, fill, color, outline, or text effects of the word have been customized.  

The shape is arranged attractively with other elements on the page. /4 

SmartArt Graphic  

There is a SmartArt graphic with pictures of products and the product names.  

Each product has a brief and persuasive description.  

The SmartArt graphic has been customized and placed to enhance the design of the flyer.  /7 

Header and Footer  

The header contains the text "Summer Heat", the dates of the sale, and the TechnoTeen logo.  

The footer contains the company name, website, phone number, and address. /2 

Text Box  

A text box below the SmartArt graphic contains promotion details.  

The text box has been formatted to attract reader’s attention and suit the layout of the flyer. /2 

WordArt  

There is WordArt expressing a catchy phrase.  

The WordArt has been formatted to attract reader’s attention and suit the layout of the flyer. /2 

Copyright Symbol  

There is a text box with advertising company name, year, and copyright symbol. /2 

Professional Publication  

The flyer is free of spelling and grammar errors.  

The elements in the flyer have been arranged attractively and do not look cluttered.  

The flyer is designed for teenagers, uses descriptive and persuasive words, and is easy to read. /14 

TOTAL /40 
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Catalog Marking Sheet 
 

Cover Page  

Picture is appealing and related to catalog theme.  

Year, catalog name, student name, company name, and date are recorded.  

The color scheme, fonts, and effects have been customized. /5 

Table of Contents  

There is a watermark that states “DRAFT.”  

There are nine entries in the table of contents. The headings and subheadings are correctly organized.  

The page numbers correspond correctly to the pages.  

The footer has a page number. The header includes company name, website, and section name. /5 

Company Message  

The page layout has been customized to 2 inch left and right margins.  

The page has a decorative border.  

A paragraph describes the company history.   

A paragraph explains how the company helps customers.  

The paragraphs are organized in two columns, with a column break separating the columns.  

There is a slogan, appropriate to the company products, written using text effects.  

Clip art is used to decorate the page.  

A cross-reference to the order form has been updated to correspond to the order form page number.  

The footer has a page number. The header includes company name, website, and section name. /15 

Order Form  

The order form is in landscape orientation.  

Order instructions include fax, mail, and phone information.   

The footer has a page number. The header includes company name, website, and section name. /15 

Product order table: 

• headings identify columns 

• borderlines divide content 

• column widths adjusted to fit content 

 

• unique table style has been applied 

• subheadings: subtotal, taxes, and grand total 

• new cells have been inserted and some erased  

The contact table: 

• billing and shipping information is in separate columns, borderlines and shading format table cells  

The payment table: 

• 1 row with 7 cells, all borderlines erased except where payment information is required  

Product Pages  

Four pages list 8 products, organized into 2 main categories with 2 subcategories each.  

Each product is attractively displayed in a table.  

The footer has a page number. The header includes company name, website, and section name.  

Each product includes: 

• name of item 

• description written to persuade buyers 

 

• appropriate, appealing picture 

• table listing product information and prices /40 

Index  

The index has 8 entries. Each entry is the product item name.  

The item page numbers are updated and correspond to the correct product pages.  

The footer has a page number. The header includes company name, website, and section name. /10 

Professional Publication  

The publication is free of spelling and grammar errors.  

The information is logically organized into sections.   

The information on each page is arranged attractively and is easy to read. /10 

TOTAL /100 
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Mail Merge Marking Sheet 
 

Letter 
 

Header  

Address of the company is at the top of the letter.  

Address block with personalized information of the recipient is below the company address.  

There is an appropriate greeting line. /3 

Body  

Sales event is described in detail.  

The event provides an incentive for customers to buy the products.  

Letter contains original, creative, or unique ideas for a sales promotion. /3 

Closing  

There is a suitable farewell line.  

There is a signature line. /2 

Professional Publication  

The letter is written in a professional manner.  

The letter is free from spelling and grammar errors. /2 

TOTAL /10 

 

 

 

 

 

Labels 
 

The correct label style was used. /2 

There are 3 different records on the sheet. /1 

Each record is made from an address block. /1 

The font size of the text has been resized to fit the label. /1 

TOTAL /5 

 

 

 

Letter and Labels TOTAL /15 
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Newsletter Marking Sheet 
 

Organization Name Banner  

• created using text effects 

• decorated using clip art 

• easy to read and attractive /3 

Table of Contents  

• created using a floating table 

• arranged neatly on the first page 

• includes six entries 

• displays page numbers /4 

Event Summary  

• title identifies the article 

• description outlines important information 

• picture illustrates the event 

• picture is well-formatted /4 

Note of Appreciation  

• title identifies the article 

• description outlines important information /2 

Upcoming Events  

• title identifies the article 

• numbered list of three events 

• shape is formatted to draw attention to list /3 

Reminders  

• title identifies the article 

• bulleted list of two reminders /2 

Tips  

• title identifies the article 

• three tips are organized in a SmartArt Graphic 

• SmartArt Graphic is formatted attractively 
/5 

Calendar  

• title identifies the article 

• page is landscape 

• copyright information is at right margin 

• calendar includes headings (month, day) 

• calendar has well-formatted cells 

• dates are numbered (period removed) 

• upcoming events are organized in cells 

/8 

Page Layout  

• header: date, web address, issue number 

• footer: organization contact information 

• page number is in the margin 

• border is applied to the first section 

/5 • copyright information in footer includes symbol 

Professional Publication  

• newsletter is free of spelling and grammar errors 

• information is well-written 

• content is arranged attractively on the page /4 

TOTAL /40 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



Ivanna Job 
10 Hierme Road 
Jobb, ON, L8W 2J1 
 
November 30, 2021 
 
Mrs. Teacher  
TechnoAd Agency 
2097 TechnoDrive 
TechnoVille, ON, L7R 0A5 
 

Dear Mrs. Teacher: 

I am writing in response to your advertisement for an Advertising Agent in Employment 

News, job number 112233. After reading the description, I am confident that my skills are 

a perfect match for this position. I have the ability to create effective advertisements that 

will satisfy your customers. 

I possess the following attributes that would be an asset to your company: 

• quick to learn new skills 

• knowledge of Microsoft Word 

• team player 

• creative talents including painting and photography 

Attached is a copy of my resume. I would welcome the opportunity to discuss my 

suitability for the Advertising Agency position. Contact me at 111-101-1001or by email at 

ivannajob@kneedwurc.com to schedule an interview. 

Thank you for your consideration. 

Sincerely, 

 

Ivanna Job 

Enclosure 



IVA N N A  JO B  
10 Hierme Road, Jobb, ON, L8W 2J1 

(111) 101-1001 ivannajob@kneedwurc.com 
 

OBJECTIVE 

Designer of advertising material including flyers, product catalogs, and brochures. 

 

SUMMARY 

 enthusiastic, hardworking, reliable 

 experience designing brochures, flyers, and posters 

 willing to learn and accept constructive criticism 

 enjoy contributing to a team effort 

 

EDUCATION 

TechnoSchool 2020 – Present 

• 82% average 

• Relevant courses: Visual Arts 

 

WORK EXPERIENCE 

Landscaper 2019 – 2021 

• Cut the lawn, trim the hedges, and weed flowerbeds for neighbors 

• Clear debris from property 

• Listen to customers to understand their needs 
 

Babysitter 2018 – 2019 

• Provide care to the children of neighbors and family members 

• Make nutritious snacks, lunch, and dinner 

• Organize activities to entertain children 
 

Fundraiser 2018 – 2021 

• Canvas the neighborhood for donors to raise money for the Cancer Society 

• Consistently raised more than $300 each year 

 

RELEVANT SKILLS 

Artistic Talent 

• Create brochures, flyers, and posters 

• Excellent understanding of the principles and elements of design 

• Photograph quality portraits, landscapes, and streetscapes 

• Paint in various styles using water colors and acrylics to produce unique artwork 

• Familiar with print making techniques such as rubbing, stamping, and stencil 
 

Teamwork 

• Collaborate with others to produce artwork such as collages 

• Review artwork and offer feedback to improve design elements 
 

Computer Knowledge 

• Proficient with Microsoft Word  

• Excellent Internet research skills 

• Skilled with digital forms of communication such as email, text, and social media 
 

References available upon request. 



 

  

2024 

Jake Rayner 

Pet Plus 

9/18/2024 

Pet Plus Catalog 
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MESSAGE FROM THE PRESIDENT 

 

Pets Plus opened its first store ten 

years ago. Today, we have stores 

all over the country. Our focus on 

only selling high-quality products is 

the secret to our success.  

 

At Pets Plus, we offer our 

customers products for their dogs 

and cats. We have some exciting 

new items for our dog lovers. The 

latest dog beds are comfortable 

and easy to clean. We also have 

some fun toys that will make your 

cat purr with joy. 

 

 

At Pets Plus, pets are family. 

 

  

 

For order information see page 5 
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DOGS 

BEDDING 

 

Comfort Plus Bed 

• Durable 

• Washable 

• Three Colors Available 
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Extended delivery terms. Please allow 3-5 weeks for delivery. 

 

Model Number Description Price 

D-1450 Brown Comfort Plus Dog Bed $29.99 

D-1451 Red Comfort Plus Dog Bed $29.99 

D-1452 Blue Comfort Plus Dog Bed $29.99 

 

 

Cozy Mat 

• Cotton Cover 

• Polyester stuffing 

• Attractive 

R
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The cozy mat is sure to become your dogs favorite snuggle spot. 

 

Model Number Description Price 

D-1450 Brown Comfort Plus Dog Bed $29.99 

D-1451 Red Comfort Plus Dog Bed $29.99 

D-1452 Blue Comfort Plus Dog Bed $29.99 
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CARRIERS 

Happy Trails Stroller 

• Maximum pet weight 30 lbs. 

• Folds in 5 seconds 

• Water-repellant nylon fabric 

• Parking break 
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Storage area for treats, toys, and cup holders. 

 

Model Number Description Price 

D-6220 Blue Happy Trails Stroller $84.99 

D-6221 Pink Happy Trails Stroller $84.99 

 

 

 

Sportster Stroller 

• Maximum pet weight 75 lbs. 

• Includes rain cover 

• Swivel front wheel 

• Three wheel design 

• Sun roof on hood 

• Reflective side strips 

• Cup holder 

W
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Includes bike attachment and flag. 

 

Model Number Description Price 

D-6390 Red Happy Trails Stroller $169.99 

D-6391 Blue Happy Trails Stroller $169.99 
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ORDER FORM 

Order Instructions 

• Fax your order to 1-905-631-9112 

• Mail your order to Pets Plus, 447 Kerr St., Oakville, ON, L6K 3C2 

• Phone our customer service department at 1-800-221-7921 

Model Number Description Quantity Price Total 

     

     

     

     

     

     

  Subtotal  

Taxes  

GRAND TOTAL  
 

Bill To:   Ship To:  

Name   Name  

Address   Address  

City   City  

Province/State   Province/State  

Postal/Zip Code   Postal/Zip Code  

Phone Number   Phone Number  

Email Address   Email Address  

 

 

Payment Credit Card Type  Card Number  Expiry Date  
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CATS 

SCRATCHERS 

 

 

Sweetheart Scratcher 

• 3 feet tall 

• Great place for cats to scratch 

• Levels can be used as a kitty staircase 

• 2 sisal rope scratch posts 

• Two sizes 

• Four color choices 

• Simple assembly required 

 

    

Red Purple Pink Yellow 

 

Model Number Description Price 

C-4220 24" Red Sweetheart Scratcher $129.99 

C-4221 24" Purple Sweetheart Scratcher $129.99 

C-4222 24" Pink Sweetheart Scratcher $129.99 

C-4223 24" Yellow Sweetheart Scratcher $129.99 

C-4224 36" Red Sweetheart Scratcher $159.99 

C-4225 36" Purple Sweetheart Scratcher $159.99 

C-4226 36" Pink Sweetheart Scratcher $159.99 

C-4227 36" Yellow Sweetheart Scratcher $159.99 

 

 

Cat City Scratcher 

• The perfect lounging and scratching experience for your kitty. 

• 3 levels 

• 2 sisal rope scratch posts 

• Dimensions 13" x 20 " x 30" 

 

Model Number Description Price 

C-5622 Cat City Scratcher $134.99 
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TOYS 

 

Watch as your kitty pounces and plays for hours on end. 

 

 

Pet Pouncer 

• Full of catnip 

• Colorful tinsel-filled balls 

• Plastic wand 

 

 

Model Number Description Price 

C-7541 Pet Pouncer $5.99 

   

 

 

 

Play-n-Squeak Mouse 

• 2" long 

• Soft and playful 

• Will satisfy your cat's preying instinct safely 

 

 

Model Number Description Price 

C-8663 Play-n-Squeak Mouse $3.99 
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